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Abstract: This guide gives a detailed description of how to use the StratiGraph tool.
For theoretical background, the theory of canonical structures and stratification on
orbits and bundles are presented. A detailed example also shows how this can reveal
the complete hierarchy of all nearby canonical structures to a given input structure.
The features of StratiGraph are then shown in detail, beginning with how to enter a
problem setup, i.e., how to define the properties of the starting canonical structure
represented as a starting node. We then continue to explain how structure information
is shown in the interface and how the starting node can be expanded both upwards
and downwards to reveal the complete stratification as a connected graph. Also other
features are shown, such as how to print and save expanded graphs as well as how
to view the structure information in different notations and font sizes, and how to
load plug-ins. Included are also several examples, e.g., a nilpotent case and a control
application.
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1. Introduction

1 Introduction

1.1 Background

The determination of the Jordan form of a matrix or the Kronecker form of a matrix
pair or pencil is an ill-posed problem in the presence of roundoff errors. Therefore
there exists modern numerical software, such as GUPTRI [2, 3] that regularizes these
problems by allowing a tolerance for rank decisions to find their canonical structure.
However, the algorithms used are known to occasionally fail and thereby accidentally
producing wrong, but nearby structures. Failure appears to occur when the matrix or
pencil is close to a manifold of interesting structures of higher codimension. Alan
Edelman, Erik Elmroth and Bo Kågström [4, 5] have proposed to make use of the
mathematical knowledge of stratification of the Jordan and Kronecker structures in
order to enhance the staircase algorithm. The stratification, in effect, shows which
structures are nearby other structures (in the sense of being in the closure) in the space
of matrices. The stratification can be described as a connected graph, that grows
exponentially with increasing matrix dimension.

StratiGraph is a Java-based tool that gives a unique opportunity to view and inves-
tigate qualitative information on the relation between different canonical structures of
an input setup. The stratification shows how the canonical structure can change for
small perturbations in the input data. Together with software for quantitative analysis
this gives a very good understanding on many aspects of an input problem.

StratiGraph version 1.0 was initially prototyped within a Master thesis project and
has been further developed into the new version 1.4. Since the original version, the
software tool has gained a lot of functionality to help the user understanding the nature
of his/her input problem.

1.2 And so it begins

In Figure 1, parts of the StratiGraph environment is shown. In the main window a
graph representing the stratification of a matrix pencil is displayed. Here the complete
graph is expanded but more common is to view a closure relation between a subset
of different canonical structures. On the right, a window which lists all the expanded
canonical structures is shown.

In this User’s Guide all the functionalities of the software will be covered, in-
cluding the background information necessary for understanding and make use of the
information presented.
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FIGURE 1: In the StratiGraph main window (left), an example of a connected graph represent-
ing the stratification of a 3× 5 matrix pencil is shown. On the right is a list of all
the canonical structures visible in a separate window.
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2. Some definitions

1.3 Outline

Section 2 presents some definitions and explanations of the terminology used in this
document. The Jordan and Kronecker canonical forms and the meaning of orbits and
bundles are explained and finally there is a discussion on integer partitions and their
application in the stratification theory.

In Section 3, we present an example illustrating the use of the stratification in prac-
tice. Covering relations and different notations are discussed. It is also shown, how
small perturbations in the input problem can result in different canonical structures.

Section 4 explains how different input setups (matrix, matrix pencil or matrix pair)
can be given to StratiGraph. Additional parameters in the setup specify how eigenval-
ues should be treated, how to specify the problem size, and which canonical structure
to start from.

The expansion of a graph and the relation between different nodes are discussed
in Section 5. How to get the best overview of available information and the graph is
also covered.

Additional functionalities of StratiGraph are presented in Section 6. Section 7 and
discuss current limitations, ongoing work and research. In Appendix A, a set of dif-
ferent examples are given. Appendix B covers all available commands in StratiGraph
and Appendix C covers the available short cuts.

1.4 Collaboration

This work is done in close collaboration with professor Bo Kågström1 and associate
professor Erik Elmroth2. Stefan Johansson3 has also helped a lot with the research,
testing of the software and finding bugs.

2 Some definitions

2.1 Matrices and Jordan structures

An n×n matrix A with n distinct eigenvalues with corresponding eigenvectors xi, has
the following decomposition:

AX = XJ,

where X = [x1,x2, ...,xn] and J = diag(λ1,λ2, ...,λn). Matrix A is then said to be diag-
onalizable.

1 bokg@cs,umu.se, Department of Computing Science, Umeå Univeristy.
2 elmroth@cs,umu.se, Department of Computing Science, Umeå University.
3 stefanj@cs,umu.se, Department of Computing Science, Umeå University.
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A matrix with multiple eigenvalues can have less than n linearly independent
eigenvectors. Such a matrix is not diagonalizable, and can not be decomposed into
the form above. However, a matrix can always be transformed into a block diagonal
form [7]:

X−1AX = diag(λ1I +N1, ...,λt I +Nt),

where λ1, ...,λt are distinct eigenvalues and Ni is a strictly upper triangular nilpotent
matrix of size ai×ai. The size ai is called the algebraic multiplicity of the eigenvalue
λi. The number of linearly independent eigenvectors corresponding to an eigenvalue
is called the geometric multiplicity, gi. If ai > gi, the eigenvalue is said to be defective
and if gi > 1, the corresponding eigenvalue λi is said to be derogatory. If a matrix has
at least one defective eigenvalue, the matrix is said to be a defective matrix.

If an eigenvalue is defect, it does not have enough number of linearly independent
eigenvectors to construct the matrix X . To get a complete base, so called principal
vectors are used. For an eigenvalue λi with geometric multiplicity gi, there exists gi

principal chains (one corresponding to each eigenvector),

(A−λI)x(l)
i = x(l−1)

i , for l = 2,3, ...,hi,

where hi is the height (length) of the chain, l is the grade of a principal vector x(l)
i , and

x(1)
i is an eigenvector. For simple eigenvalues, h = 1 and l = 1. The relation above can

also be written in matrix form as:

AXi = XiJhi(λi),

where Xi = [x(1)
i ,x(2)

i , ...,x(hi)
i ] and Jhi(λi) is a Jordan block of size hi×hi:

Jhi =



λi 1
λi 1

. . . . . .
. . . 1

λi


For a general matrix A, with t distinct eigenvalues, X = [X1,X2, ...,Xt ] and t Jordan

matrices J(λi) can be formed. The matrix is then said to be in Jordan normal form
(JNF) or Jordan canonical form (JCF),

X−1AX = diag(J(λ1),J(λ2), . . . ,J(λt)),

where
J(λi) = diag(J

s(i)1
(λi),Js(i)2

(λi), . . . ,Js(i)gi
(λi)).
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2. Some definitions

2.2 Matrix pencils and Kronecker structures

Given two matrices A and B of size m×n, A−λB is called a matrix pencil . If m = n
and B = In this corresponds to A−λI. A generalized eigenvector and a generalized
eigenvalue is a vector x 6= 0 and a scalar λ that satisfy

(A−λB)x ≡ 0.

A general matrix pencil can have both left and right singular blocks as well as both
finite and infinite eigenvalues (infinite if B is singular). The generalization of the JNF
to matrix pencils is the Kronecker Canonical Form (KCF). All m× n matrix pencils
can be transformed into KCF [7]:

P−1(A−λB)Q = diag(Lε1 , . . . ,Lεp ,J(λ1), . . . ,J(λt),LT
η1

, . . . ,LT
ηq),

where P (m×m) and Q (n× n) are nonsingular. J(µ1), . . . ,J(µt) form the regular
structure and are Jordan blocks of the finite and infinite eigenvalues:

J j(λi)≡


λi−λ 1

. . . . . .
. . . 1

λi−λ

 and J j(∞)≡


1 −λ

. . . . . .
. . . −λ

1


L j and LT

j correspond to the minimal indices of a singular pencil:

L j ≡


−λ 1

. . . . . .

−λ 1

 and LT
j ≡


−λ

1
. . .
. . . −λ

1

 .

An j× ( j + 1) block L j is called a right singular block (associated with a column
minimal index) and an ( j +1)× j LT

j block is called a left singular block (associated
with a row minimal index). L j has the right singular vector xT

j = [1 λ λ2 . . . λ j]
such that L jx j = 0 for any scalar λ. Similarly, LT

j has a left singular vector xT
j =

[1 λ λ2 . . .λ j] such that xT
j LT

j = 0 for any scalar λ. The right and left singular blocks
form the singular structure of A−λB.

2.3 Matrix pairs

Matrix pairs (A,B) or (A,C), where A ∈ Cn×n, B ∈ Cn×p and C ∈ Cq×n, appear in
state-space systems, e.g., the controllability and observability pairs of matrices. For
example, [A B] (or [A−λI B]) is the controllability pair (or pencil) of the system
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ẋ = Ax+Bu,

where x is the state vector, A is the system matrix, u is the input vector and B is the
input matrix of the system. Similarly,[

A
C

]
(or

[
A−λI

C

]
)

is the observaibility pair (or pencil) of the system

ẋ = Ax+Bu
y = Cx

where y is the output vector and C is the output matrix of the system.
The stratification of the set of such pairs give qualitative (structural) information

about the controllability and observability characteristics of nearby systems.
The canonical form consists of Jordan blocks and right singular blocks for (A,B),

and Jordan blocks and left singular blocks for (A,C). An example when looking at the
controllability pencil of a linear system is presented in Example 4 in Appendix A.

2.4 GUPTRI form

To compute the JNF or the KCF of a problem can be ill-conditioned. A denser canon-
ical form, called generalized Schur-staircase form can however be computed using
only unitary transformations. This form is a block upper triangular form that reveals
the structure elements of the KCF or JNF.

The GUPTRI4 form of a matrix pencil is a generalized Schur-staircase form that
separates the singular and regular parts of the problem [2, 3]:

PH(A−λB)Q =

 Aright−λBright ∗ ∗
Areg−λBreg ∗

Aleft−λBleft

 ,

where P (m×m) and Q (n× n) are unitary. The rectangular upper block triangular
Aright−λBright has only right minimal indices in its KCF, the same L j blocks as A−λB.
Similarly, the Aleft−λBleft only has left minimal indices in its KCF, the same LT

j block
as A− λB. Areg − λBreg is an upper triangular block that contains all the finite and
infinite eigenvalues of A−λB.

4 GUPTRI form is an acronym for Generilized UPer TRIangular form.
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Notice that the GUPTRI form can also be used for matrices and matrix pairs. For
matrices this means that B = In, A is n× n and Q = P. Consequently, A− λB can
have no left or right minimal indices or infinite eigenvalues and the GUPTRI form
is therefore equal to Areg − λBreg. For matrix pairs, the only differences are that A
and B in A−λB have the structures described in Section 2.3. Since the B matrix has
full row rank for controllability pairs, they can not have any left singular indices (LT

blocks), and since it has full column rank for observability pairs, they can have no
right singular indices (L blocks).

2.5 Orbits and bundles

Two square matrices, A and C, are said to be similar if there exists an invertible matrix
P such that

C = P−1AP.

The set of all matrices similar to a matrix A defines the orbit of the matrix, i.e.,

O(A) = {P−1AP|det(P) 6= 0}.

Notice that O(A) consists of all matrices with the same eigenvalues and the same
Jordan structure as A.

Two matrix pencils, A1 − λB1 and A2 − λB2, are said to be strictly equivalent if
there exists non singular matrices, P and Q, such that

A2−λB2 = P−1(A1−λB1)Q.

The set of all equivalent pencils to A−λB defines the equivalence orbit of the pencil,
i.e.,

O(A−λB) = {P−1(A−λB)Q|det(P)det(Q) 6= 0}.

O(A− λB) consists of all pencils with the same eigenvalues and the same KCF as
A−λB.

The equivalence orbits of the controllability and observability matrix pairs (pen-
cils) are defined as follows:

O[B, A−λIn] = {[P−1B, P−1(A−λI)Q] |det(P) ·det(Q) 6= 0}

O

[
A−λIn

C

]
= {

[
P−1(A−λIn)Q

CQ

]
|det(P) ·det(Q) 6= 0}

A bundle is a union of orbits. If a matrix or pencil has the same canonical structure
except that the distinct eigenvalues are different, they are said to be in the same bundle.
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2.6 Codimension

The dimension of an orbit or bundle is equal to the dimension of its tangent space
and is uniquely determined by the Jordan or Kronecker structure. To be specific,
these orbits and bundles of matrices are manifolds in the n2-dimensional space of
n× n matrices. Similarly, the orbits and bundles of matrix pencils and matrix pairs
are manifolds in spaces of dimension 2mn and n(n + p), respectively. In practice, it
is more convenient to work with the dimension of the space complementary to the
tangent space, denoted codimension.

The difference between orbits and bundles are, that in a bundle, the eigenvalues
are not specified, i.e., the tangent space of a bundle spans one extra dimension for each
distinct eigenvalue compared to the corresponding orbit. In conclusion, the codimen-
sion of an orbit is the same as the corresponding codimension for the bundle plus the
number of distinct eigenvalues.

EXAMPLE 1

For a generic m×n matrix pencil, A−µB, the tangent space of the bundle (and
the orbit if m 6= n) spans the complete 2mn space. Therefore the codimension
of that pencil is 0 (cod(A−λB) = 0). All degenerate pencils has a codimension
greater that 0. The most degenerate matrix pencil (i.e., both A and B are all
zeros) has a zero-dimensional tangent space and therefore the codimension of
that pencil is 2mn.

EXAMPLE 2

For a generic orbit of a n× n matrix, A, with n eigenvalues the codimension
is n. Each specified eigenvalue limits the degree of freedom by one, i.e., the
space complementary to the tangent space is of dimension n. It does not matter
if A has multiple eigenvalues or not. If A gets rank deficient and hence less
generic, the codimension further increases and for the zero matrix the orbit is
zero-dimensional, i.e., the codimension is n2.

2.7 Integer partitions

A partition, κ, of an integer n is a sequence (k1,k2,k3, ...) such that k1 +k2 +k3 + . . . =
n and k1 ≥ k2 ≥ k3 ≥ . . .≥ 0. Further, an integer partition is said to dominate another
partition ν, i.e., κ > ν if k1 + k2 + . . .+ ki ≥ v1 + v2 + . . .+ vi for i = 1,2, . . ., where
ν 6= κ. Different partitions of an integer can in this way form a dominance ordering.
If κ > ν and there is no partition µ such that κ > µ > ν, then κ is said to cover ν.
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2.8 Stratification

Edelman, Elmroth and Kågström [5] show how Jordan and Kronecker structures can
be represented as integer partitions such that the closure relations of the various orbits
and bundles are revealed by applying simple rules on these partitions. The closure
relations or the closure hierarchy forms the stratification of Jordan and Kronecker
structures. The stratification defines a partial ordering on orbits and bundles. One
structure is said to cover another if its closure includes the closure of the other and
there is no other structure in between.

A structure can never be covered by a less or equally generic structure. This im-
plies that structures within the closure hierarchy can be ordered by their dimension (or
their codimension). We remark that several orbits (or bundles) in a closure hierarchy
can have the same codimension.

3 Stratification by example

As mentioned before, the knowledge of stratification gives information about nearby
structures that can be described as a connected graph5.

3.1 A nilpotent matrix

To illustrate the theory of stratification we start by looking at a nilpotent matrix of size
6×6. Of course, any matrix with a single multiple eigenvalue µ can be made nilpotent
by a shift, A−µI.

Consider a matrix Ã with canonical structure J4(µ)⊕J2(µ), i.e., two Jordan blocks,
one of size four and one of size two, both with the eigenvalue µ. Assume that the
matrix is reduced to a GUPTRI form A−µI = PH(Ã−µI)P:

A−µI =


0 A12 A13 A14

0 0 A23 A24

0 0 0 A34

0 0 0 0

 =



0 0 × × × ×
0 0 × × × ×
0 0 0 0 × ×
0 0 0 0 × ×
0 0 0 0 0 ×
0 0 0 0 0 0


. (1)

Remark that the superdiagonal blocks A12, A23, and A34 of (1) have full column
rank and define the “stairs” in the GUPTRI form. Each block Aii+1 is of size wi×wi+1.

5 Thereby the name StratiGraph.
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3.2 Canonical forms and Weyr characteristics

The wk indices of the GUPTRI form reveal the Jordan normal form of the nilpotent
matrix. In each step of the staircase algorithm, the nullspace of a deflated submatrix of
A−µI is computed. In the first step, w1 = dimN (A−µI) is computed and generally,

wk = dimN (A−µI)k−dimN (A−µI)k−1 for k ≥ 2.

In other words, w1 is the number of eigenvectors and wk is the number of principal
vectors of grade k associated with µ. In example (1), A has

w1 = 2 A has 2 eigenvectors,
w2 = 2 A has 2 principal vectors of grade 2,
w3 = 1 A has 1 principal vector of grade 3,
w4 = 1 A has 1 principal vector of grade 4,

and consequently
w1 = 2 = dimN (A−µI),
w1 +w2 = 4 = dimN (A−µI)2,

w1 +w2 +w3 = 5 = dimN (A−µI)3,

w1 +w2 +w3 +w4 = 6 = dimN (A−µI)4.
The number of principal vectors of grade k is equal to the number of Jordan blocks J j

of size j× j with j ≥ k. The GUPTRI form (1), tells us that we have 2 Jordan blocks
of size ≥ 1, 2 Jordan blocks of size ≥ 2, 1 Jordan block of size ≥ 3, and finally, 1
Jordan block of size ≥ 4, i.e., we have one Jordan block of size 2 and one of size 4.

The wk indices are also referred to as the Weyr characteristics. For our exam-
ple with canonical form J4(µ)⊕ J2(µ), the Weyr characteristics associated with the
eigenvalue µ are the following list of wk values: J (µ) = (2 2 1 1).

Without loss of generality, we assume that µ = 0 in the following subsections.

3.3 Covered structures

We continue to investigate the GUPTRI form of our nilpotent example. Now, assume
that A34 is almost rank-deficient. This means that α in (2) is a small number close to
the machine precision. What happens if we instead consider this value to be zero?

0 0 × × × ×
0 0 × × × ×
0 0 0 0 × ×
0 0 0 0 × ×
0 0 0 0 0 α

0 0 0 0 0 0


(2)
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3. Stratification by example

In other words, how does the canonical structure change when α → 0? From (2), we
see that w3 will increase by 1 and w4 will decrease by 1. The new GUPTRI form will
be 

0 0 × × × ×
0 0 × × × ×
0 0 0 0 × ×
0 0 0 0 × ×
0 0 0 0 0 0
0 0 0 0 0 0


, (3)

with the Weyr characteristics J = (2 2 2), indicating that there are no Jordan blocks
of size 1 or 2, but two of size 3. The largest Jordan block has decreased in size and
the second largest has grown. The matrix in (3) has the canonical structure 2J3(0).

Next, let us consider the superdiagonal block A12 of the nilpotent matrix A in
GUPTRI form (1). Since it has full column rank, A12 can be further reduced to an
upper triangular (or even diagonal) form:

0 0 α × × ×
0 0 0 β × ×
0 0 0 0 × ×
0 0 0 0 × ×
0 0 0 0 0 ×
0 0 0 0 0 0


. (4)

How does the canonical structure change if we consider A12 to be rank-deficient. For
example, this happens if α→ 0 in (4). Now, the canonical structure expressed in Weyr
characteristics would be J = (3 1 1 1) with the GUPTRI form

0 0 0 × × ×
0 0 0 × × ×
0 0 0 0 × ×
0 0 0 0 × ×
0 0 0 0 0 ×
0 0 0 0 0 0


. (5)

The J2 block has split into two 1×1 J1 blocks. This matrix has the canonical structure
J4(0)⊕2J1(0).

Since we have imposed more rank deficiency in the original nilpotent matrix (1),
the resulting GUPTRI forms (3) and (5) represent nilpotent matrices with more de-
generate canonical forms. They also are said to be less generic.
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In conclusion, we have made (1) less generic by changing different values into
zero in (5) and (3). When looking at the space spanned by the orbit of the three ma-
trices (i.e., the space spanned by the set of all similar matrices) they all span different
“subspaces”. However, the spaces spanned by the orbit of (5) and the orbit of (3) are
both in the closure of the space spanned by the orbit of (1), i.e, O(J4(0))⊕ J2(0))
covers both O(J4(0))⊕2J(0)) and O(2J3(0)).

As mentioned before, any matrix with a single multiple eigenvalue µ can be made
nilpotent by a shift, A− µI. This implies that the statement can be made even more
general by saying that O(J4(µ)⊕J2(µ)) covers both O(2J3(µ)) and O(J4(µ)⊕2J1(µ)).

3.4 Covering structures

We can also look at the two less generic nilpotent matrices the other way around. By
introducing a small perturbation α in the GUPTRI forms (3) and (5), respectively, we
obtain the original structure (1) in both cases.

What if we are interested in perturbations that make the original nilpotent matrix
more generic? We can do this by adding a small but nonzero value α to (1) giving the
following GUPTRI form: 

0 0 × × × ×
0 0 × × × ×
0 0 0 α × ×
0 0 0 0 × ×
0 0 0 0 0 ×
0 0 0 0 0 0


. (6)

The nilpotent matrix (6) has the Weyr characteristics is J = (2 1 1 1 1), i.e., the
covering and more generic structure is J5(0)⊕ J1(0). If we continue to add another
small perturbation β so that all superdiagonal blocks are 1× 1 and nonzero (i.e., of
full rank), we get the following GUPTRI form

0 β × × × ×
0 0 × × × ×
0 0 0 α × ×
0 0 0 0 × ×
0 0 0 0 0 ×
0 0 0 0 0 0


. (7)

The nilpotent matrix (7) corresponds to the most generic nilpotent matrix of size
6×6 with the canonical structure J6(0).
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3. Stratification by example

We have in this example by adding a small values to (1) made it more generic in
(6) and (7). The orbit of (1) is in the closure of the orbit of (6) and that orbit is in
the closure of the orbit of (7). From this follows that (1) also is in the closure of (7).
We say that O(J4(0))⊕J2(0)) is covered by O(J5(0)⊕J1(0)) and O(J5(0)⊕J1(0)) is
covered by J6(0).

3.5 Canonical structure hierarchy

This example shows that with small perturbations, one can go from one canonical
structure to another more generic structure. In this example, it is also clear that it is
a very strict relation between them and by adding a small perturbation one can only
go to a certain set of other structures. This relation forms a hierarchy of the canonical
structures.

In Figure 2, the relationship between the discussed canonical structures using a
graph representation, where the nodes represent orbits of the different matrices, is
illustrated. In the discussion, we often only say matrix, structure, or we specify a
canonical structure, when we formally mean the orbit (or bundle) of these objects.

The canonical structure of the original matrix, A− µI, is illustrated with double
frames. Indeed, the graph shows the closure hierarchy between these five structures.
We have shown that with a small perturbation one can go from O(2J3(0)) to O(J4(0)⊕
J2(0)), i.e., O(2J3(0)) is in the closure of O(J4(0)⊕J2(0)) and O(J4(0)⊕J2(0)) cov-
ers O(2J3(0)). We also say that both O(2J3(0)) and O(J4 ⊕ 2J1(0)) are covered by
O(J4(0)⊕J2(0)). With a small perturbation one can also go from O(J4(0)⊕J2(0)) to
O(J5(0)⊕ J1(0)). The closure relations above also imply, that with at small perturba-
tion one can go from O(2J3(0)) to O(J5(0)⊕J1(0)) and further on to the most generic
structure O(J6(0)).

If there is a connected path in the graph from one node to another, then all struc-
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���
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FIGURE 2: Relation between some canonical structures of a 6× 6 nilpotent matrix orbit. The
top three nodes in the graph correspond to the similarity orbits of (7), (6) and (1),
respectively.
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tures on that path below a given node are in the closure of its orbit (or bundle). With
a small perturbation it is always possible to go from a less generic structure to a more
generic structure in the closure hierarchy. The complete closure hierarchy of the set
of 6×6 nilpotent matrices is presented in Figure 3.
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FIGURE 3: Jordan structure hierarchy of a 6×6 nilpotent matrix orbit.

4 Describe your problem setup

When StratiGraph is started, a dialog window (Figure 4) is shown asking whether the
user would like to open a blank window, an already saved graph or the graph wizard.
The graph wizard helps to define your problem setup, including the starting structure.
The input structure is the point of departure for investigating neighboring structures
above and below in the (closure) hierarchy.

4.1 Supported problem setups

The first step in the new graph wizard is to choose between the currently three sup-
ported problem setups, namely, matrices, matrix pencils, and matrix pairs (Both (A,B)
and (A,C) cases). When a problem setup is selected, a brief explanation is shown (See
Figure 5). Choose a current problem setup and continue to the next step of the wizard.
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FIGURE 4: The dialog window shown when StratiGraph is started.

FIGURE 5: In the first step of the new graph wizard one can choose between different problem
setups. Together with each setup a short description is shown.

4.2 Fixed or nonfixed eigenvalues

As presented in Section 2.5, an orbit is for a matrix the set of all similar matrices, and
for matrix pencils and matrix pairs, the set of all strictly equivalent matrix pencils or
pairs.

A bundle is a union of orbits. If a matrix or pencil has the same canonical structure
except that the distinct eigenvalues are different, they are said to be in the same bundle.

In practice, if the problem, for physical or other reasons, has a well-determined
clustering of the eigenvalues then the orbit stratification is typically of interest. Other-
wise, the bundle stratification is likely to be more useful. The choice between looking
at the orbit or bundle stratification is done as illustrated in Figure 6, showing the sec-
ond step in the wizard.
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FIGURE 6: In the second step of the new graph wizard one can choose between looking at the
orbit or bundle stratification.

FIGURE 7: In the third step in the wizard, further information on the setup is given, such as the
size and starting structure. Here the user has specified to look at the stratification of
the orbit of a matrix pencil (Figures 5 and 6) of size 2× 3, starting with the most
generic pencil. The resulting canonical structure is shown at the bottom.

4.3 Problem size

In the third and final step of the new graph wizard, the size and starting structure is
specified. One can choose between starting with the most or least generic structure of
a given size, or a problem with a given canonical structure.

If the most or least generic structure is chosen, the size is specified directly and
the corresponding canonical structure is automatically derived (See Figure 7).
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If the canonical structure is known or at least presumed, this information can be
entered by choosing “Other structure”. Then the individual canonical blocks must be
entered. In the matrix case, the Jordan blocks corresponding to each distinct eigen-
value are specified. For matrix pairs, the sizes of right singular blocks are also re-
quested, and for matrix pencils also left singular blocks may appear. If no blocks of
a specific type occurs in the canonical structure, the field is left empty. If the system
has several blocks with the same size, they can also be entered as, e.g., 2*1, meaning
two blocks of size one.

In Figure 8, the canonical structure of a matrix pencil with one right singular block
L1 of size 1×2 and one Jordan block of size 1×1 is entered as the starting structure.
The canonical structure, L1⊕ J1(µ1), is shown at the bottom left corner of the wizard
window.

Notice that no explicit values of the distinct eigenvalues are requested or specified
by the user.

FIGURE 8: The canonical structure L1⊕ J1(µ1) is entered as the starting structure. Blocks are
entered by their sizes and the resulting structure is shown at the bottom left corner
of the wizard window.

5 Expanding a graph

After the graph wizard is closed, the first node in the graph will appear in the main
window. This node represents the orbit or bundle corresponding to the structure of the
specified problem.
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5.1 The node

On each node two numbers are displayed (Figure 9). The topmost number indicates
the codimension of the corresponding orbit or bundle, i.e., the same number that also
is visible in the left margin. The lowermost number indicates an order number that
identifies individual nodes with the same codimension (and hence aligned on the same
horizontal level in the graph).

By right-clicking on the node, all the information given about the structure (i.e., in
most cases the canonical structure) will be presented. The information is shown until
the mouse is clicked or the cursor is leaving the window. If the CTRL key is pressed,
information about more then one node can be viewed at the same time.

FIGURE 9: A node with the two numbers indicating the codimension and the order on that
codimension level. This node indicates that the corresponding structure L1⊕J1(µ1)
has codimension 2 and that it is the first structure expanded with that codimension.

5.2 Expansion

The starting node is surrounded by a pattern looking like waves as can be seen in
Figure 10. This node can now be expanded both upwards and downwards to see if
and in that case which other structures that are nearby. Small triangular indicators
on the edge of the node signal whether the node can be expanded or not (Figure 10).
A triangle at the top of the node indicates that there exists at least one unexpanded
outgoing edge upwards. Similarly, if there is a triangle on the bottom edge of the
node, then there exists at least one unexpanded outgoing edge downwards.

A node is activated and thereby colored red by clicking on it. An active node can

FIGURE 10: The three figures show different indicators a node can have. They are from the
left; the starting node; a node that can be expanded both upwards and downwards;
a leaf node that have no downwards going edges.
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then be expanded upwards by clicking on the upper half of the node, and downwards
by clicking on the lower half of the node. Any node connected to an active node is
colored blue and the rest of the nodes are green.

Nodes in the graph are ordered vertically by their codimension. If two nodes
represent different structures but with the same codimension they are aligned on the
same level. In the left margin of the graph window the codimension for each displayed
level of nodes are shown (See Figure 11).

FIGURE 11: Here the starting node has been expanded one step both upwards and downwards.
Notice how the nodes are aligned vertically and horizontally by their codimension.

If there is no triangle at the edge of a node, no further outgoing edges exists and
nothing will happen if one try to expand it. A node with no downwards going edges
is called a leaf node and they are indicated by a stylized arrow head (see Figure 10).

The graph can also be expanded recursively, i.e., when a node is expanded down-
wards (or upwards) it will continue to expand the covered (or covering) nodes down-
wards (or upwards). This will proceed until no new nodes can be found. Also the
complete graph can be expanded. During this process a dialog window will appear
(Figure 12) showing the progress of the expansion and it also provide a way to halt the
expansion process. Notice that even a fairly small initial structure can produce a huge
graph and consequently will take a lot of memory and computer resources to compute.
Recursive expansion is therefore only recommended on small graphs.

Recursive expansion can be found using the menu under the item “Graph” and also
on the button bar as the buttons depicting several levels of nodes. A complete descrip-
tion of all the menu choices and menu buttons is presented in Appendix Appendix B.

5.3 The relation between neighboring nodes

An edge between two nodes indicates that the nodes’ corresponding structures are
forming a covering relation in the space of matrices (matrix pencils, or matrix pairs).
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FIGURE 12: Dialog window shown when recursive expansion is done. Already for moderate
problem sizes this could be a time and memory consuming operation.

The edges themselves show the canonical structure transitions between two con-
nected nodes. When right clicking on an edge, information on which blocks in the
upper connected node that have changed in order to get the lower connected node is
presented. Notice that only blocks that have changed are presented, not the complete
canonical structure. An example is displayed in Figure 13. We refer to Edelman-
Elmroth-Kågström [5] for the rules of canonical structure transitions in the stratifica-
tion process.

FIGURE 13: Here L1 ⊕ J1(µ1) covers L0 ⊕ J1(µ1)⊕ J1(µ2). By right-clicking on the edge, we
can see that the L1 block has changed to L0⊕ J1(µ2).

5.4 Rearrange a graph

The algorithm that places the nodes tries to get as few edge-crossings as possible.
However, sometimes it is desirable to change the placements of the nodes due to aes-
thetical reasons or because a group of nodes have a special relation. Nodes can not
change its vertical positions (they can not change codimension), but they can be moved
horizontally.

A node is moved by dragging them, holding the left mouse button. When a node
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is dragged, a node without identification numbers will appear. Moving the mouse
sideways will move the node. The node is given the new position when the button is
released. The node will snap into some positions at a regular distance to help rear-
ranging the graph nicely. The node numbers are left unchanged by this operation.

5.5 Structure overview in separate windows

For better overview of how structures are related, a separate window can be opened
that only displays a subset of the generated structures, i.e., the current active node and
the closest related nodes (Figure 14). Nodes with a lower codimension connected to
the active node (i.e., the active node is in their closures) have a blue arrow pointing
upwards in front of them. Structures with a higher codimension (i.e., in the closure
of the active node) and connected with the active node have a blue arrow pointing
downwards. The currently active node has a red arrow pointing to the right in front of
it. Above each node both their codimension and order in their codimension layer are
displayed, i.e., the same information as displayed on the graph node itself.

Another window displays a list with all the generated nodes (Figure 14). The same
set of symbols as in the window above are displayed in front of the nodes. For nodes
not directly connected to the currently active, a green bullet is displayed in front of the
structure.

To activate one of the structures and make the corresponding node active in the
main window, click on it with the mouse pointer.

FIGURE 14: To the left, the window showing covering, active and covered structures is shown,
and to the left, the window showing all generated structures are shown.
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5.6 Scaling and overview of the graph

The total number of nodes grows exponentially with the size of the problem. Already
for moderate-sized problems the total number of structures and thereby the number of
nodes in the graph can be very large. In these cases, it is therefore not often useful to
look at the complete graph but more likely a subset of the graph. But even in those
cases the graph window can be too small to fit all the desired nodes. In those cases,
the built in scaling functionality can be of use. The graph can be scaled down to 1%
and up to 200% of the original size.

The scaling tool can be found in the tool bar with the button depicting a magnifying
glass or in the menu under ”View → Zoom”. The dialog window opened (Figure 15)
looks like an arrow where the desired scale factor is adjusted by dragging the mouse
pointer up or down. When the mouse button is released the graph will be rescaled.

Another way to better adjust the scaling is to automatically rescale the graph so
that it fits the current graph window. This is done by clicking on the button in the
tool bar depicting a magnifying glass surrounded by three small arrows or in the menu
under ”View → Zoom to fit”. Then the graph is either zoomed down or up to best fit
the graph window.

FIGURE 15: The scale is set by pressing the left mouse button and adjusting the level from 1 to
200 %.

6 Additional functionality

6.1 Exporting and printing a graph

StratiGraph can export graphs and structures to PostScript-files that can be viewed
or printed. A print dialog window (Figure 16) is opened by clicking on the button
depicting a printer in the tool bar or in the menu under ”File → Print”. In the dialog
window one can specify which information to export, i.e., either only the graph, only
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FIGURE 16: The dialog window for exporting a graph with corresponding structure information
to PostScript.

the structure information or both. Also the paper size its orientation (landscape or
portrait format) can be specified.

The graph can also be exported as an Encapsulated PostScript file (EPS). This is
done by selecting the EPS check-box. In this case the node information can not be
included, only the graph.

Also, the name of the file to which the graph will be exported must be given. A
default name will be suggested and then the file will be saved in the current working
directory, but both the name and location may be changed either manually or with a
file-dialog window.

6.2 Saving and loading a graph

When working on a problem setup, one may want to save an expanded graph for later
use. By clicking on the button depicting a floppy disk or using the menu under ”File
→ Save”, a file dialog window is opened where a name for the saved graph can be
specified.

A graph is loaded by clicking on the button depicting an opening folder or using
the menu under ”File → Open”. Then previously saved files can be browsed. Under
the ”File” menu a list of previously saved files are also presented. By clicking on one
of these, the graph is automatically loaded.

6.3 Different notation and font sizes

The default notation for canonical structure information is block structure notation
where the individual blocks are presented like L0 ⊕ J1(µ1), representing a right sin-
gular block of size zero (0× 1) and one Jordan block of size one (1× 1) with the
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associated eigenvalue µ1.
Two other notations are currently also available, namely Weyr characteristics and

Segre characteristics. The Weyr characteristics are discussed in Section 3.2. In Exam-
ple 3 and Example 4 the two characteristics are illustrated. Figure 17 shows how all
three notations are used in StratiGraph. The notation currently used is shown in the
status bar of the main window.

EXAMPLE 3

The structure
LT

1 ⊕LT
0 ⊕ J3(µ1)⊕2J1(µ1)

is written as
L = (2 1) J (µ1) = (3 1 1)

in Weyr characteristics. L = (2 1) says that there are two left singular bocks
LT

j with j ≥ 0 and one LT
j with j ≥ 1, i.e., there is one left singular block

LT
0 and one block LT

1 . J (µ1) = (3 1 1) represents three Jordan blocks J j with
j ≥ 1, one block with j ≥ 2 and finally one block with j ≥ 3 all corresponding
to the same eigenvalue µ1. This means that we have two J1(µ1) blocks and one
J3(µ1) block.

EXAMPLE 4

Segre characteristics list the sizes of the canonical blocks in decreasing order.
The structure

LT
1 ⊕LT

0 ⊕ J3(µ1)⊕2J1(µ1)

is written as
L = (1 0) J (µ1) = (3 1 1)

in Segre characteristics. L = (1 0) says that there are one left singular bock LT
j

of size 1 (1× 2) and one of size 0 (0× 1). J (µ1) = (3 1 1) says that we have
one Jordan block of size 3 and two Jordan blocks of size 1 all corresponding
to the same eigenvalue µ1.

Besides choosing between different notations of the structures, one can change the
displayed font size. Three different sizes are available, namely 12pt, 14pt and 16pt.
The font sizes are available under the menu ”Options → Font size”.
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FIGURE 17: The same structure information given with different notations. From left to right
the structures are shown in block structure notation, Weyr characteristics, and
Segre characteristics.

6.4 Viewing options

Besides the ones already described, a number of options for the graph are available.
The horizontal as well as the vertical distance between nodes can be changed. This
can make a very broad graph more compact or a graph with lots of connections more
easy to overview. The distance is changed under ”Options→ Node distance”. A small
window is then opened where the values can be changed (Figure 18).

The symbols describing non-expanded nodes, leafs and starting node can be turned

FIGURE 18: The distance, both horizontal and vertical, between the nodes can be adjusted to
make the graph more or less compact.
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on and off. This is done under ”View → Decorations”.
A graph can also be displayed in a more compact way. In a compact layout all extra

space between two codimension layers where there are no nodes are not visualized.
The compact layout can be selected under ”View → Compact graph layout”.

6.5 Loading Plug-ins

Two different kinds of plug-ins can be loaded into StratiGraph, i.e., either a program
extension or a new problem setup. The extensions add some kind of functionality to
the software, e.g., the ability to communicate with third party software. Currently,
there are three different kinds of problem setups supported by StratiGraph, four if
you count the (A,B) and (A,C) matrix pair setups as different. As the research in this
area continues it is likely that more setups will be added like matrix triples (A,B,C)
etc. StratiGraph already supports the addition of new setups that can be loaded as a
plug-in with the plug-in manager. The Plug-in manager is opened under ”Options →
Plug-in manager” and the window is shown in Figure 19.

If you like to use a new plug-in, first follow the installation instructions with the
plug-in. In the top text field, enter the name of the plug-in and press the “Add” button.

FIGURE 19: The plug-in manager window. A plug-in called “Matlab” is identified by the pro-
gram and is ready to be loaded.
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If the plug-in is found an information text will appear under “Available Plug-ins” and
the plug-in is now ready to be loaded. Mark the plug-in by clicking on the information
text and then press the “Load” button. The plug-in is then loaded into the program and
can be used. The plug-in information will also be moved to the “Loaded plug-ins” list.
To unload a plug-in, select the information text and press the “Unload” button.

Next time StratiGraph is started the plug-in will be automatically identified and
added to the “Available Plug-ins” list, but not loaded. If you like that plug-in to also
be loaded, there is a check-box on the right that can be marked.

7 Limitations and future developments

7.1 Current limitations

When expanding even small problems the total number of nodes in the graph can
be very large. The number of nodes grows exponentially with the problem size. A
large graph requires more memory and computer resources to construct. A very large
graph also does not provide much useful information (though it is interesting to view).
Therefore one might need to be careful in the expansion process especially when it
comes to recursive expansion. Try to only expand parts of the graph that are of interest.

StratiGraph is run with a Java virtual machine (JVM), and usually a JVM restricts
how much memory that can be used by the software. If memory problems occur, refer
to the JVM manual for that computer platform.

The only way to export the expanded graph is to Post Script (PS) or Encapsulated
PS (EPS). However, these formats can be converted to PDF or different image formats
using appropriate software.

7.2 Supported problem setups

Ongoing research with new knowledge in this field is constantly added into Strati-
Graph. Currently StratiGraph supports matrices, matrix pencils and matrix pairs. The
ambition is to add functionality for matrix triples and matrix quadruples.

7.3 Expansion options

When the graphs get very large it would be useful to collapse or even remove parts of
the graph to be able to focus on different aspects of the problem. Also the ability to
expand the graph to find specific structures or highlight specially interesting subsets
of nodes is also planned to be added.
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7.4 Quantitative results

StratiGraph in this version focuses on qualitative results, i.e., the stratification process
and associated structures. One major field of interested connected to the stratification
is different quantitative information given specific input data. Plug-ins that communi-
cate with the Matlab environment are developed and are planed to be incorporated in a
future version of StratiGraph. Given a set of data in Matlab, StratiGraph then provides
the stratification graph together with quantitative information, including distances to
nearby structures.
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Appendix A Examples

In the following examples, we illustrate the complete stratification of some small-sized
problems including different problem setups.

Example 1 – Nilpotent matrix

In Section 3, we considered a nilpotent matrix when introducing stratification by ex-
ample. Now we illustrate the same example using StratiGraph.

A nilpotent matrix has only one eigenvalue (that is 0). Also, this eigenvalue can
never be changed, because, then the matrix would not be nilpotent anymore. There-
fore, when looking at nilpotent matrices only the orbit case (fixed eigenvalues) are of
interest and only matrices with one eigenvalue. Matrices with only one eigenvalue can
be made nilpotent by shifting the matrix with its eigenvalue (A−µI).

Looking at the same example as in Section 3 in StratiGraph, we specify a matrix-
case, and choose “Other structure” and “Orbit”. We specify the Jordan structure (4 2)
for one eigenvalue (Figure 20).

When finishing the wizard, the starting node will appear in the middle of the graph
window. Following the example in Section 3, the graph is first expanded downwards
by clicking on the lower part of the node. This will create the two closest downward
neighbors, the same structures as in the staircase forms (3) and (5), namely 2J3(µ1)
and J4(µ1)⊕2J1(µ1). Similarly, expanding the starting node upwards gives the same

FIGURE 20: For a nilpotent matrix we specify the matrix case and looks at the stratification
of the orbit. The block sizes are given for a nilpotent matrix with the canonical
structure J4(0)⊕ J2(0). Notice that we only have one (non-specified) eigenvalue.

171



Paper V

FIGURE 21: The orbit stratification of a 6× 6 nilpotent matrix. In the left window, the graph
is expanded upwards and downwards starting from J4(0)⊕ J2(0). In the right
window, all generated structures are displayed.

structure as in (6), namely J5(µ1)⊕ J1(µ1).
After the node expansion is repeated and completed, the same graph as in Figure

3 appears (Figure 21).

Example 2 – Matrix as orbit and bundle

In the next example, we look more closely on the difference between an orbit and
a bundle case. When looking at structures in a given orbit, the eigenvalues do not
change. If the canonical structure contains singular blocks, eigenvalues can disappear
and appear, but one existing eigenvalue can not change into another or split into differ-
ent ones. When looking at bundles, the eigenvalues can however change and coalesce,
and we can get new ones or loose some.

The example is a 4× 4 matrix. The initial canonical structure has two Jordan
blocks of size 2 and 1 corresponding to one eigenvalue µ1, and one Jordan block of
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size 1 corresponding to µ2.

J2(µ1)⊕ J1(µ1)⊕ J1(µ2).

We first consider the matrix orbit case, where all eigenvalues are kept fixed. The
single Jordan block corresponding to µ2 can obviously not be changed, but the regular
3× 3 part corresponding to µ1 can change. The 2× 2 Jordan block J2(µ1) can split
into J1(µ1)⊕ J1(µ1) (less generic) or J1(µ1)⊕ J2(µ1) can merge into a 3× 3 Jordan
block J3(µ1) (more generic). The complete orbit stratification is shown in Figure 22.

FIGURE 22: The orbit stratification of a 4×4 matrix.

In a bundle case however, we get many more possibilities. Of course, the same
cases that appear in the orbit case exist also in the bundle case. The eigenvalues
can change but does not have to. For example, we get a more generic case when
J2(µ1) splits into two Jordan blocks with one new eigenvalue creating a matrix with the
canonical structure 2J1(µ1)⊕ J1(µ2)⊕ J1(µ3). The most generic case is a matrix with
four Jordan blocks, all with different eigenvalues, i.e., the typical case for a random
matrix.

Considering more degenerate neighbors, we also get different new structures that
do not appear in the orbit case. For example, we can have two eigenvalues coalescing
into the same eigenvalue and we get a J3(µ1) block.

The complete graph for this small bundle example is shown in Figure 23. Already
in fairly small examples the total number of different structures can be plenty. How-
ever, usually one is not interested in the complete graph, but small subgraphs which
show the structures in the vicinity of the starting node.
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FIGURE 23: The bundle stratification of a 4×4 matrix.

Example 3 – Matrix pencils

In this example, we look at a matrix pencil of size 3×5, i.e.,

A−λB

where A,B ∈ C3×5. We are starting with the most generic structure that is L1⊕L2 in
both the orbit and bundle cases, i.e.,

A−λB =

[
L1

L2

]
=

 −λ 1 0 0 0
0 0 −λ 1 0
0 0 0 −λ 1

 (8)

The least generic pencil is of course when both A and B are zero matrices, that is,
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FIGURE 24: To view the stratification of a 3× 5 matrix pencil we start with the most generic
pencil L1⊕L2.

A−λB = 5L0⊕3L0. In both the orbit and bundle cases, we get the same set of nodes
in this example but the way they are related differs.

Eigenvalues can calesce and split in the bundle case, but not in the orbit case.
However in the orbit case we can see new eigenvalues emerge by structure transitions
in the singular blocks [5].

The largest regular part in this 3× 5 example is 3× 3. In an orbit case, the most
interesting thing is if this regular part only has one eigenvalue. In that case the most
generic structure is J3(µ) that covers J2(µ)⊕J1(µ) that in turn covers the least generic
structure 3J1(µ). This small connected graph can also be found as a subgraph in the
matrix pencil as seen in Figure 25. If the regular part instead has two distinct eigenval-
ues, this also forms a small subgraph with J2(µ1)⊕J1(µ2) that covers 2J1(µ1)⊕J1(µ2).
However, since the eigenvalues can not change these two subgraphs are never con-
nected. That is, with a small perturbation one can not go from one of the subgraphs to
the other and still be in an orbit with a covering relation. The same apply to the third
subgraph (with only J1(µ1)⊕ J1(µ2)⊕ J1(µ3)) that corresponds to the case when the
regular part has three distinct eigenvalues.

Then looking at the bundles of the same pencil, the regular part behaves differently.
Since the eigenvalues can coalesce and split, the whole 3×3 regular part is connected
in one subgraph (See the right graph in Figure 25). That is, when looking at bundles,
one can with a small perturbation go from a canonical form with multiple eigenvalues
to a canonical form where they have split into distinct eigenvalues and still be in a
bundle with a covering relation with the original.
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FIGURE 25: The complete graph illustrating the stratification of a 3×5 matrix pencil. On the
left the orbit case is shown and on the right the bundle case is shown. In both
graphs, the subgraphs of the pencils with a 3×3 regular part are highlighted. The
other nodes have no regular part or a regular part of size 1×1 or 2×2. The figures
illustrate how eigenvalues can change and merge in the bundle case but not in the
orbit case.
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Example 4 – Control application

Several characteristics of linear state-space models, such as controllability and observ-
ability, can be described in terms of matrix pencils (e.g., see [1, 3, 11]). Consider the
linear system

Eẋ(t) = Ax(t)+Bu(t),

where E and A are n× n and B is n× p. The system is controllable if, starting
with x(0) = x0, it is possible to choose the input u to bring the state vector x to an
arbitrary state in some finite time tN . One way to characterize controllability is via the
controllability pencil

C (E,A,B) = [B|A]−λ[0|E].

It has full rank except at k < n values of λ, which correspond to the uncontrollable
modes of the linear system above.

Controllability decision is an ill-posed problem in the sense that small perturba-
tions in the data may drastically change the behavior of the system. Therefore, it is
of great value to know the stratification of the controllability pencil and thereby get
qualitative information of nearby canonical structures.

Consider a system with three states (n = 3) and two inputs (p = 2), i.e., a 3×5 con-
trollability pencil. In the left part of Figure 26, the graph for the bundle stratification
of the set of matrix pencils of size 3×5 is displayed. This gives the complete picture,
but several of the Kronecker structures represented in the graph are not possible for
this application. Let A ≡ [B|A] and B ≡ [0|E], and we assume that E is nonsingular.
Then it follows that A−λB can only have L j blocks and finite eigenvalues. The sub-
stratification corresponding to these cases are displayed in the top-right part of Figure
26, starting from the node labeled “0 over 1” and ending at the node labeled “14 over
2”. The generic case is L1 ⊕ L2, which corresponds to a controllable system. This
graph is obtained by treating the controllability pencil as a matrix pair, which in this
case automatically rules out some cases that appear in the stratification of the set of
3×5 matrix pencils.

Notice that the codimension of the bundles in both graphs are the same but not
their dimensions. The dimension of the bundle of the most generic pencil L1 ⊕ L2

(codimension 0) has the dimension 30 (2mn) in the matrix pencil stratification, but
dimension 15 (n(n+ p)) in the matrix pair stratification (Section 2.6).

We remark, that at codimension level 2 there are two structures L0⊕L3 and 2L1⊕
J1(µ1). The last case represents a system with one uncontrollable mode, and a con-
trollable subspace of size two. The structure L0 ⊕ L3 represents a system which is
controllable, but only for one of the two input variables.
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The least generic case 2L0⊕3J1(µ1) corresponds to a system with three multiple
uncontrollable modes.

FIGURE 26: To the left, the complete graph illustrating the bundle stratification of a 3×5 matrix
pencil is shown. The highlighted subgraph contains the nodes corresponding to
the possible canonical forms when looking at the pencil as a matrix pair. That
subgraph is identical to the graph illustrating the bundle stratification of a 3× 5
matrix pair that is show on the right.
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Appendix B StratiGraph commands

Menu bar

. File

. Open Open a saved graph.

. Save Save the graph to file.

. Print Export the graph to PostScript.

. About Shows version and author information.

. Exit Exits StratiGraph.

. Graph

. New graph

Open the graph wizard.
. Set active as start node

Set the active node as starting node. Has meaning in some plug-
ins.

. Expand upwards

Expand the active node upwards.
. Expand recursive upwards

Expand the active node upwards recursively.
. Expand downwards

Expand the active node downwards.
. Expand recursive downwards

Expand the active node downwards recursively.
. Expand complete graph

Expand the complete graph.

. View

. Show covers

Open a window that shows the closest neighbouring nodes to the
active node. Off as default.

. Show generated structures

Open a window that shows all generated structures. Off as default.
. Show tool bar

Shows the tool bar. On as default.
. Show status bar

Shows the status bar. On as default.
. Decoration
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. Mark starting node

Mark the starting node with a wave-shaped decoration.
On as default.

. Mark expandable nodes

Mark nodes with small triangles at the top or bottom if
they are expandable. On as default.

. Mark leaf nodes

Mark the leaf nodes, i.e., nodes that do not cover any
new nodes.

. Compact graph layout

Switch to compact graph layout. Off as default.

. Zoom Open the zoom dialog window.

. Zoom to fit

Zoom the graph to fit the window.

. Options

. Node distance

Open the dialog window to change the distance vertically and hor-
izontally between the nodes in the graph.

. Notation

. Block structure notation

Change the structure notation to block structure nota-
tion.

. Weyr characteristics

Change the structure notation to Weyr characteristics.
. Segre characteristics

Change the structure notation to Segre characteristics.
. Font size

. 12pt Show structure information in 12pt font size.

. 14pt Show structure information in 14pt font size.

. 16pt Show structure information in 16pt font size.
. Plug-in manager

Open the plug-in manager.
. Save options

Save the options. This is automatically done when StratiGraph
closes.
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Button bar

Open the Graph Wizard.

Open a saved graph.

Save the current graph.

Export the graph to PostScript.

Expand the complete graph recursively.

Expand the active node upwards recursively.

Expand the active node downwards recursively.

Open a window that shows the closest neighboring nodes to the active node.

Open a window with information of all the generated nodes.

Open the zoom dialog window.

Scale the graph to fit the window.

Exit StratiGraph.
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Appendix C Keyboard short cuts

Global short cuts

The action key is different on different systems. On a Windows based system it is
usually the left CTRL key and on a UNIX based system it is usually the left Alt. key.

Action + O Open a saved graph.

Action + S Save the current graph.

Action + E Export the graph to PostScript.

Action + Q Exit StratiGraph.

Action + N Open the Graph Wizard.

Action + U Expand the active node upwards.

Action + Shift + U Expand the active node upwards recursively.

Action + D Expand the active node downwards.

Action + Shift + D Expand the active node downwards recursively.

Action + A Expand the complete graph recursively.

Graph window short cuts

U Expand active node upwards

D Expand active node downwards

Move active node to the node with lowest order number on the nearest upper
codimension level.

Move active node to the node with lowest order number on the nearest lower
codimension level.

Move the active node to the node with nearest lower order number.

Move the active node to the node with nearest higher order number.
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